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Process Model & Simulation

• Process Model
“ An abstraction or simplified logical representation of a real or conceptual 
complex system. It is designed to display significant features and  characteristics 
of the system under study.”

• Simulation
“Computerized model that possesses the characteristics described above and that 
represents some dynamic system or phenomenon.”
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Other Application Areas

• Design and Analysis of Manufacturing systems

• Evaluation of military weapons and their logistics
– Flight simulation, war game simulation, etc.

• Determination of protocols and requirements for 
communication systems

• Design and experimentation of transport systems (airport, 
freeways, and subways)

• Evaluation & Re-engineering of business processes (hospitals, 
call centers, and post offices)

• Analysis of financial and economic systems

• Evaluation of Inventory systems
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System Dynamics Approach

• Involves following concepts [Richardson 
91]
– defining problems dynamically, in terms of graphs over time
– striving for an endogenous, behavioral view of the significant dynamics 

of a system
– thinking of all real systems concepts as continuous quantities 

interconnected in information feedback loops and circular causality
– identifying independent levels in the system and their inflow and outflow 

rates 
– formulating a model capable of reproducing the dynamic problem of 

concern by itself
– deriving understandings and applicable policy insights from the resulting 

model
– implementing changes resulting from model-based understandings and 

insights.

• Dynamic behavior is a consequence of 
system structure
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Applicability to Software Processes

Software development is a very dynamic and complex 
process. Therefore, simulation (with system 

dynamics) is well-suited to analysis of software 
process improvement strategies.

• Global system perspective

• Accounts for process feedback effects

• Model inherent tradeoffs among cost, schedule, and 
quality

• Critical path analysis to schedule as opposed to 
traditional cost reduction analysis

• Low-cost experimentation

6

Software Process Control System

Software 
Process

Software ArtifactsRequirements, resources etc.

internal project feedback

external feedback from operational environment

Software Development or Evolution Project
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Simulation Model Benefits

• Process change/technology insertion experimentation via simulation 
without tying up valuable resources (CMM-Level 5)

– Trade-off analysis and process optimization

• Quantitative evaluation of the software process (CMM- Level 4)
– Effects of process strategies on cost, schedule, and quality

– Experimentation of process changes before commitment

– Interactive training for software managers via “process flight simulation”

– Process re-engineering implementation

– Continuous calibration of simulation model with available data

• Encapsulation of under standing processes 
– Organizational learning

• Benchmark of process improvement using the calibrated simulation 
model to the organizational data
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Discrete Event Vs. Continuous

• Discrete Event Simulation
– Modeling of a system as it evolves over time by a representation in which 

the state variables change instantaneously at separate points in time 
(Events)

– Conceptually could be done by hand calculations. But, because of the 
amount of data stored and manipulated for most real world system, it can 
be done on a digital computer

– Tools: e.g. - Arena, AweSim, Extend

• Continuous Simulation
– Modeling over time of a system by representation in which the state 

variables change continuously with respect to time
– Involve differential equations that give relationship for the rates of change 

of the state variables with time
– Tools: e.g. - SIMULINK, Dymola, iThink, etc
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Hybrid Simulation

• Modeling with the aspects of both discrete-event and 
continuous simulation

• Three fundamental interactions b/w discretely changing and 
continuously changing state variables [Pritsker 1995]
– A discrete event may cause a discrete change in the value of a continuous state 

variable

– A discrete event may cause the relationship governing a continuous state 
variable to change at a particular time

– A continuous state variable achieving a threshold value may cause a discrete 
event to occur or to be scheduled

• Tools: e.g. – AweSim, Extend

10

Modeling Heuristics
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I - Conceptualization

• Define a clear, operational purpose of the model

• Don’t try to model the “System”

• Aggregate and abstract to the appropriate degree

• Use a top-down iterative approach

• KISS – (Keep It Simple, Stupid)

12

II - Formulation & Development

• Don’t enumerate all factors at first

• Refine the model iteratively

• Add relationships to the model slowly

• Normalize when possible/Use relative measures

• Don’t stay too far from a simulatable model

• Don’t model in isolation; Try to involve those being modeled
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III - Validation

• Look for qualitative similarity on the first pass

• Alter one parameter at a time at a first

• Be conscious of reality constraints

• Model validity is a relative matter
“ The usefulness of a mathematical simulation model should be 

judged in comparison with mental image or other abstract 

model which would be used instead. Models are successful if 

they clarify our knowledge and insights into systems” [Jay W. 

Forrester, MIT]
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IV - Miscellaneous

• Data Collection
– Model design should not be postponed until all pertinent parameters 

have been actually measured

• Communication
– Use simple diagrams to communicate with others until they seek more 

details
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V - General

• No Model is perfect, but some are useful

• All models are incomplete

• No model is final

– Possibility to build many different models of a single 

process

• All models contain hidden assumptions

• Continually challenge the model

16

Building a Simulation Model
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Simulation Modeling Steps
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1. PLANNING

The issues must be discussed in the planning:
– Overall objectives of the study

– Specific questions to be answered by the study

– Performance measures used to evaluate the efficacy of different system 

configurations

– Scope of the model

– System configurations to be modeled

– Software to be used

– Time frame  and required resources
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2. Collect Data & Define a Model

• Collect information on the system layout and operational 
procedure

• Collect data to specify model parameters and input probability 
distribution

• Determine the level of the model
• Build a conceptual model: “Assumptions”

– Must be validated before building the simulation model

• Collect data on the performance of the existing system
• Need not be a one-to-one correspondence b/w each element of 

the model and the corresponding element of the system
• Regular basis meeting with key personnel (subject-matter 

experts, managers)

20

Determine the Level of Model

• Feasible with time, money, and computer constraints

• Careful definition of the specific issues to be investigated by study and 

measures of performance

• Determine the entity moving through the simulation model (e.g. Release, 

Feature, or Module)

• Use subject-matter experts for important components of the system and 

sensitivity analyses  for important parameters & fit distributions 

• Start with  a “Moderately Detailed” model then embellish it

• Make the level of the model consistent with available data

• Incrementally increase the level of the model
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Collection of High Quality Data

• Identify the true subject-matter experts for sub 
systems to avoid collecting biased data

• Provide a precise specification of data 
requirements

• Understand the process that produces the data
• Use existing theory for random distribution

– (e.g. customer service arrival time: Poisson)

• Use relevant result from similar simulation 
studies

• Use experience and Intuition
– Hypothesize how certain components of a complex system operates

22

Potential Difficulties with Data

• Not representative of what one really wants to 
model

• Not of appropriate type or format
• May contain measurement, recording, or 

rounding errors
• May be biased because of self-interest
• May have inconsistent units
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Randomness in the Simulation Model

• Allows different system designs to be compared in a more 
statistically efficient manner

• Represented by probability distribution, not just perceived 
mean value

• If no theoretical distribution that is good fit for a particular 
distribution
– Continuous: Weibull, lognormal, normal, uniform

– Discrete: Triangular, beta, binomial, geometric, Poisson, negative 
binomial, discrete uniform

• Very few normal distribution in real simulation

• Simulation results from different runs – Independent
– Using separate sets of different random numbers

24

3. Build a Baseline Model

• Implement the model using a selected 
simulation software after the validation of the 
conceptual model validation

• Verify the simulation model
– Run the simulation under a variety of input settings to see that output is 

reasonable

– Trace state variables and statistical counters to see if the simulation 
model is operating as intended

– Interactive debugging if it is provided by the tool

– Observe an animation of the simulation output



2016-05-13

13

25

4. Validate the Simulation Model

• Make pilot runs

• Compare model and system performance measures for the 
existing system (Most definitive validity test) – Results 
Validation
– Model Accuracy – Depends on its intended use and the utility function

• No Completely definitive approach for the validation

• Review of the model results for the correctness by the analysts 
and the subject-matter experts

• Determine what model factors are significant on performance 
measures by using sensitivity analyses

26

5. Experiments with the Simulation Model

• Design experiments
– Specification of each system configuration of 

interest
• Length of each run

• Length of warm-up period, if appropriate

• Number of independent simulation runs using different 
random numbers
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Design of Experiments

• Primary Goals

– To show the statistical significance of an effect that a particular factor exerts 

on the dependent variable of interest 

– To extract the maximum amount of unbiased information regarding the factors 

affecting a production process from as few (costly) observations as possible

• General Issues in Experimental Design

– How to design an optimal experiment

– How to analyze the results of an experiment

• Design Techniques

– e.g. : 2k factorial design, 2k-p factorial design, Central Composite and Non-

Factorial Response Surface Designs, Latin Square Designs, Taguchi Methods, 

etc.

– 2k factorial design and 2k-p factorial design will be explained in more detail

– For other designs, refer to the URL 

http://www.statsoftinc.com/textbook/stexdes.html

28

2k Factorial Designs

• Two levels for each factor
• Simulation runs at each of 2k possible factor-level 

combinations (design points)
• Specify a reasonable values for the quantitative factor that are 

meaningful options for qualitative factor
• Example: 23 factorial design
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2k-p Factorial Designs

• As the number of factors gets larger, a full 2k factorial design 
become unmanageable and requires considerable 
computational efforts

• Choose a certain subset of all 2k possible design points
– if p=1, half fraction: if p=2, fourth fraction, and so on.

• Example: 24-1 fractional factorial design with one replication

30

6. Analyze the Simulation Outputs

• Two main objectives of analyzing output data
– Determine the absolute performance of certain system configurations

– Compare alternative system configurations in a relative sense
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Introduction to ExtendSim

32

Getting an ExtendSim Demo Version

• Download ExtendSim V8 demo version from the URL: 
– http://www.extendsim.com/prods_demo.html

Fill out the form and click 
Submit button to download a 
demo version from the web
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Launching the Extend Demo

• After Installing the demo version on your PC

• Double-click on the ExtendSim 8 Demo icon on your desktop or Go to the 
Programs folder and open the ExtendSim 8 Demo.

• A model file “demo.mox” will open automatically.

• Click on the buttons to view a sampling of the example models that ship with 
this Demo.

34

Limitations of Demo Version 

• Can not Print or Save !!

• While you cannot print or save with this non-expiring Demo, 
you can:
– Explore the features and capabilities of the four ExtendSim products 

(ExtendSim Suite, ExtendSim AT, ExtendSim OR, and ExtendSim CP) 

– Use it as a Player to run models of any size and view simulation results 

– Build (but not save) small models (75 blocks or less) 

– Change (but not save) parameters in any size model 

– Add or remove blocks and change connection lines in existing small 
models (75 blocks or less; additions and changes are not saved)*

– Create new blocks and save them in libraries
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Open a Model

• Choose “Open…” from File menu

• Select a model file (*.mox) from Open Dialog
– (Sample Models in the directory: \ExtendSim7Demo-Player\Examples)

36

Model Basic Components

Blocks

Dialog

Connectors

Connections

Hierarchical Block
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ExtendSim Model Basics - Blocks

• Composed of an icon, a dialog for entering and 
viewing data, and connectors

• Used to represent a portion of the model like a 
block in a block diagram

• Different Kinds of Blocks
– Represents a source of information that is passed on to other blocks

– Modify information as it passes through them

– Output information from the simulation in a visible form

• Hierarchical Block: 
– A Block that contains groups of other blocks

• Any number of instances of the same block 
can be used in a model

38

ExtendSim Model Basics - Libraries

• Repositories of blocks

• When a block is included in a model, a reference to the block in the library 
is included

– Automatic update by changing the definition of a block in the library

– Save a great deal of disk and RAM space

• When a model is saved, all model blocks and their locations in the libraries 
are saved

• Three ways to open a library
– Automatically when a model is opened

– Choose Open Library from the Library menu

– Specify pre-load libraries in the preferences command in the Edit menu

• To add a block from a library
– Open the library and select the library from the list in the menu

– Select a block from the submenu organized by block type
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Libraries that come with 
ExtendSim

• Value
– Used for continuous simulations
– Values change when time changes

• Item
– Used for models that use queues, item-specific attributes, and priorities
– Model attributes change when events occur

• Plotter
– Used to graph model outputs

• Animation
– Used to add animation effect to models and hierarchical blocks

• Utilities
– A collection of useful blocks which count the number of blocks in a 

model, fit data to a curve, synchronize the model to real time, and so 
on.

• Extendsim allows the user to create his/her own libraries 
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ExtendSim Model Basics - Dialogs

• Used to enter values and settings before running the 
simulations

• To open a block’s dialog
– Double-click on the block’s icon

– Hierarchical blocks – show contained blocks in them

• Information about a block
– Click on the help button at the bottom left corner of the dialog

• Displays report values during simulation if they are opened 
during the simulation

• Values and setting can be changed during the simulation
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Extend Model Basics –
Connectors & Connections

• Connectors
– Information flow into/out a block

– Attached to each side of block

– Input/Output connector by pre-defined functions

Connections
Connecting lines to hook blocks together

Show the information flow from block to block

During the simulation, the flow proceed along the path of connections repetitively

D

T U

Value Input Connector

Item Input Connector
Value Output Connector

Item Output Connector

Value Connection

Item Connection
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Adding a Block to the Model

• Open the library if necessary
• Choose a block from Library 

menu

•Open the library window
•Select a block from a opened 
library, Drag it, and Drop it into 
the model window
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Moving Blocks

• Select the block(s) you want to 
move

• Drag to the position where you 
want to move

• Let go of the mouse button

• Select the block(s) you want to 
move

• Move selected blocks one pixel 
at a time using the arrow keys
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Connecting Blocks

• Move the cursor to the output 
connector of A (The cursor 
changes to a technical drawing 
pen)

• Click the output connector
• Drag it toward the input 

connector of B

• Let go of the mouse when the 
pen is over the input connector 
of B

• Connections from a output connector to a 
input connector are also allowed 

• Can connect from a value output connector to 
a item input connector (from a item output 
connector to a value input connector)
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Additional ways of connecting blocks

Straight connection

Right-angle connection

Select a connection type from 
Connection Line of Model menu

Disadvantage: Run directly over 
block(s) and/or line(s)

Multi-segment connection Named connection

46

Adding a Multi-segment Connection

Let go of the mouse button
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Adding a Named Connection

• Select the tool bar “A”, then 
move the mouse where you 
want to put a text

• Click the mouse button and 
add the text

• Connect the line from a 
output connector to the text

• Connect the line from the text 
to a input connector
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Labeling the blocks & Adding comments

To add a block label 
• Open the block’s dialog
• Click the label field near the bottom scrollbar
• Type the test less than 15 characters
• Close the dialog

To add comments on a block
- Most of blocks have comments field or tab
- Type the text less than 255 characters
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Removing Blocks

• Select the block(s) to be removed 
• Choose Clear Blocks from Edit 
menu or Click Delete key

• When removed, attached connection(s) to the block(s) will also be removed 

50

Saving a Model

• Can not Print or Save in a Extend Demo Version !!
• The following explains how to save a model in Extend LT version

• Choose “Save Model” from the File Menu or Ctrl + S
• Click the Save button in the tool bar
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Saving a Model As …

• Choose “Save Model as…” from the 
File menu
• Add the file name into the File name 
edit box of Save File as dialog
• Click Save button
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Simulation Setup

• Specify how the simulation will run and for how long 
• Deals with Discrete Event/Continuous as well as Random Numbers/Time Unit

Simulation End Time Simulation Start Time

Number of Simulation Runs Simulation Time Unit
- Select a time unit from the 
pull down menu
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Running the Simulation

• Choose “Run Simulation” 
from the Run menu
or
• Click Run Simulation button
In the tool bar

Status Bar during the simulation run

Actual time left
Current time of 
the simulation

Number of the 
simulation
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Q & A


